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CONCEPT OF NOTEPAD 
Notepad – Definition 

“Notepad is a very basic generic text editor included with Microsoft Windows that enables someone to 

open and read plain text files. If the file contains special formatting or is not a plain text file, Notepad 

will not be able to be read its contents.” 

 

 
 

Notepad is a common text-only (plain text) editor. The resulting files—typically saved with 
the .txt extension—have no format tags or styles, making the program suitable for editing system files to 
use in a DOS environment and, occasionally, source code for later compilation or execution, usually 
through a command prompt. It is also useful for its negligible use of system resources; making for quick 
load time and processing time, especially on under-powered hardware.  
 
 

How to open Windows Notepad 

Users who are using Microsoft Windows can run Microsoft Notepad (notepad.exe) by following the steps below. 

Windows 10 
1. On the Windows desktop, find the Windows Search Box. 

2. In the search box, type notepad. 

3. Click on the Notepad option in the search results. 

Windows 8 
1. Go to the Windows Start Screen. 

2. Type notepad and in the search results, click on the Notepad option. 

Windows 7 and earlier 
1. Click Start 

2. In the Run box, type notepad and press Enter. 

or 
1. Click the Start. 

2. In the Start Menu, click Programs or All Programs, then click the Accessories folder. 

3. Click the Notepad icon. 

How to create a text file using Notepad 

Open Notepad and type the text you want in the file. Once done, save the file by clicking File 

and then Save. When saving the file, make sure the file is saved with a .txt extension. 

or 

On the Windows Desktop or in any folder, right-click an empty spot. In the pop-up menu, 

select New and then Text Document. After this has been done, a file should appear named 

"New Text Document". Double-click this file to open the text document, or rename the file to 

the name of your choice and then open the file. 
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CONCEPT OF WORKPAD 

 
What is WordPad? 
WordPad is a Microsoft Windows program that you can use to create documents such as letters, notes 
and posters. It's less complicated than a full word processor but still lets you perform a range of tasks: 

• create, open, and save documents 
• format documents – that is, change the size and style of print, the look of a page, etc. 
• insert dates, pictures and hyperlinks 
• view a document 
• change page margins 
• print documents. 

 
 
Microsoft WordPad is a free rich text editor first included with Microsoft Windows 95 and all versions since. 
Although capable of doing more than Notepad, WordPad is not as advanced as Microsoft Word. However, it does 
give you additional features, such as the capability of inserting pictures and text formatting. The picture below 
shows an example of Microsoft WordPad. 

 
 

Microsoft WordPad is capable of editing and saving plain-text file (.txt), Rich Text Format (.rtf), 
Microsoft Word for Windows (.doc or .docx), and OpenDocument Text (.odt) format files. 
 

How to open Microsoft WordPad 

Users who are using a version of Microsoft Windows that supports WordPad can run Microsoft WordPad 

(wordpad.exe) by following the steps below. 

Windows 10 
1. Click the Start menu. 

2. Type wordpad and press Enter. 

Windows 8 
1. On the Start screen, type wordpad. 

2. In the search results, click the WordPad program. 

Windows 7 and earlier 
1. Click the Start menu. 

2. Click the Run option. 

3. Type wordpad or write, then press Enter. 

OR 
1. Click the Start menu. 

2. Click Programs and then Accessories. 

3. Click the Wordpad icon. 
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CONCEPT OF WORD PROCESSOR 

A word processor, or word processing program, does exactly what the name implies. It processes 

words. It also processes paragraphs, pages, and entire papers. Some examples of word processing 

programs include Microsoft Word, WordPerfect (Windows only), AppleWorks (Mac only), and 

OpenOffice.org. 

The first word processors were basically computerized typewriters, which did little more than 

place characters on a screen, which could then be printed by a printer. Modern word processing 

programs, however, include features to customize the style of the text, change the page formatting, 

and may be able to add headers, footers, and page numbers to each page. Some may also include a 

"Word Count" option, which counts the words and characters within a document. 

While all these features can be useful and fun to play with, the most significant improvement over 

the typewriter is the word processor's ability to make changes to a document after it has been 

written. By using the mouse, you can click anywhere within the text of a document and add or 

remove content. Since reprinting a paper is much easier than retyping it, word processing programs 

have make revising text documents a much more efficient process. 

The term "text editor" can also be used to refer to a word processing program. However, it is more 

commonly used to describe basic word processing programs with limited features. 

 
“Word processing is the phrase used to describe using a computer to create, edit, and print documents. “ 

Of all computer applications, word processing is the most common. To perform word processing, you 
need a computer, a special program called a word processor, and a printer. A word processor enables 
you to create a document, store it electronically on a disk, display it on a screen, modify it by 
entering commands and characters from the keyboard, and print it on a printer 
 
Word processors vary considerably, but all word processors support the following basic features: 
 

  INSERT TEXT: Allows you to insert text anywhere in the document. 
  DELETE TEXT:  Allows you to erase characters, words, lines, or pages as easily as you can cross them 

out on paper. 
  CUT AND PASTE : Allows you to remove (cut) a section of text from one place in a document and 

insert (paste) it somewhere else. 
  COPY : Allows you to duplicate a section of text. 
  PAGE SIZE AND MARGINS : Allows you to define various page sizes and margins, and the word 

processor will automatically readjust the text so that it fits. 
  SEARCH AND REPLACE :  Allows you to direct the word processor to search for a particular word or 

phrase. You can also direct the word processor to replace one group of characters with another 
everywhere that the first group appears. 

  WORD WRAP :The word processor automatically moves to the next line when you have filled one line 
with text, and it will readjust text if you change the margins. 

  PRINT: Allows you to send a document to a printer to get hardcopy. 
 
Features of Standard Word Processors:- 
 
Word processors that support only these features (and maybe a few others) are called text editors. Most 
word processors, however, support additional features that enable you to manipulate 
and format documents in more sophisticated ways. These more advanced word processors are 
sometimes called full-featured word processors. Full-featured word processors usually support the 
following features: 
 

  FILE MANAGEMENT : Many word processors contain file management capabilities that allow you to 
create, delete, move, and search for files. 

  FONT SPECIFICATIONS:  Allows you to change fonts within a document. For example, you can 
specify bold, italics, and underlining. Most word processors also let you change the font size and even 
the typeface. 

  FOOTNOTES AND CROSS-REFERENCES:  Automates the numbering and placement of footnotes and 
enables you to easily cross-reference other sections of the document. 
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  GRAPHICS GRAPHICS: Allows you to embed illustrations and graphs into a document. Some word 
processors let you create the illustrations within the word processor; others let you insert an 
illustration produced by a different program. 

  HEADERS , FOOTERS , AND PAGE NUMBERING:  Allows you to specify customized headers and footers 
that the word processor will put at the top and bottom of every page. The word processor automatically 
keeps track of page numbers so that the correct number appears on each page. 

  LAYOUT :  Allows you to specify different margins within a single document and to specify various 
methods for indenting paragraphs. 

  MACROS :  A macro is a character or word that represents a series of keystrokes. The keystrokes can 
represent text or commands. The ability to define macros allows you to save yourself a lot of time by 
replacing common combinations of keystrokes. 

  MERGES:  Allows you to merge text from one file into another file. This is particularly useful for 
generating many files that have the same format but different data. Generating mailing labels is the 
classic example of using merges. 

  SPELL CHECKER :  A utility that allows you to check the spelling of words. It will highlight any words 
that it does not recognize. 

  TABLES OF CONTENTS AND INDEXES: Allows you to automatically create a table of contents and index 
based on special codes that you insert in the document. 

  THESAURUS: A built-in thesaurus that allows you to search for synonyms without leaving the word 
processor. 

  WINDOWS : Allows you to edit two or more documents at the same time. Each document appears in a 
separate window. This is particularly valuable when working on a large project that consists of several 
different files. 

  WYSIWYG (WHAT YOU SEE IS WHAT YOU GET): With WYSIWYG, a document appears on the display 
screen exactly as it will look when printed. 
 
 
 

WHAT ARE THE BENEFITS OF USING WORD PROCESSOR IN THE CLASSROOM? 
 

Word processors are a valuable part of the technology now available for educators in schools. Students and 
teachers both receive many benefits when doing classwork on the computer. Many of the headaches of paperwork 
are eliminated. 
 

Spelling 
Word processors contain an electronic spell checker. The student writer has immediate feedback about misspelled 
words. Student must discern which of the computer-generated spellings is correct for the context. Teachers no 
longer have to red-ink spelling errors. They can focus on the few exceptions the spellchecker does not catch.  

Security 
Teachers and students gain a sense of security about losing assignments. When the student saves her work, she 
avoids the possibility of the assignment being lost or misplaced. If an assignment is ever misplaced, a replacement 
can be easily printed. 

Legibility 
Teachers benefit by receiving a readable copy that is easy to grade. Students with poor handwriting can increase 
their scores with better looking papers. Students should be instructed to turn in copies of work in a readable font.  

Publishing 
Work done on a word processor can easily published on a bulletin board. Teachers can create electronic 
anthologies of their students' writings. Each student can receive an electronic copy of published works with no 
printing costs. 

Mobility 
Work done on a word processor and saved on the Internet is highly portable and accessible from any computer 
with Internet access. Dogs do not eat papers in cyberspace. "I forgot it at home" is irrelevant. Just log onto the 
nearest computer and your work appears on the screen. 
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Why Teachers Use Word Processing 

• Saves time — Word processing helps teachers use preparation time more efficiently by letting them modify materials 
instead of creating new ones. Writers can also make corrections to word processing documents more quickly than they 
could on a typewriter or by hand. 

• Enhances document appearance — Materials created with word processing software look more polished and professional 
than handwritten or typed materials do. It is not surprising that students seem to like the improved appearance that word 
processing gives to their work (Harris, 1985). This is especially possible with the many templates that are part of the 
software suites today. 

• Allows sharing of documents — Word processing allows materials to be shared easily among writers. Teachers can 
exchange lesson plans, worksheets, or other materials on disk and modify them to fit their needs. Students can also 
share ideas and products among themselves. 

• Allows collaboration of documents — Especially since the release of Google Docs, teachers and students can now create, 
edit, and share documents synchronously. 

MS WORD 

Microsoft Word or MS-WORD (often called Word) is a graphical word processing program that users can type with. It is 
made by the computer company Microsoft. Its purpose is to allow users to type and save documents. 

Similar to other word processors, it has helpful tools to make documents. 

• Spelling & grammar checker, word count (this also counts letters and lines) 

• Speech recognition 

• Inserts pictures in documents 

• Special codes 

• Web pages, graphs, etc. 

• Tables 

• Displays synonyms of words and can read out the text 

• Prints in different ways 

MS Word is a part of Microsoft Office, but can also be bought separately. 
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How to use MSWORD 

Switch on your computer and wait until a whole lot of picture symbols appear with a Start button on the bottom left of 
the screen. Use the left button on the mouse to click on the Start button. Then click on programmes and then double-
click on the MSWORD programme. Some computers have a MSWORD symbol that will come up when your computer 
is on and you do not have to go to start – simply double click the left button of the mouse on the symbol. 

The Microsoft word programme will appear on the screen. 

There will be a blank screen called Document 1. Every thing you type is called a document. Above the blank screen 
there are various terms and signs you should know about. 

• The first line has a list of titles called commands - File, Edit, View, etc 

• The second and third lines are called the toolbar and have different blocks that you can use to give quicker 
commands to the computer. 

• The fourth line [if there is one] shows your page margins – it is called the ruler. 

The File title 

Click on this and a box with different sections will appear. This is your file organiser and you use the first section: 

• To start a new document (click on new) You can use the block with a folder on it on the toolbar to do this 
more quickly. Use your mouse to click on it.) 

• To open an old document (click on open) and then click on the name of the document you want to open 

• To close a document. The computer will ask you if you want to save it before you close it and then you click 
on Yes or No. 

The next section is to do with saving documents. 

If you press save, the document will be saved under its heading in the general folder called My Documents. You can 
do this with the block on the toolbar showing stiffy disk. Click on it with your mouse. 

Save As allows you to save a document under a new name in the folder of your choice. When you click on Save as, a 
new box will open on screen. First go to the Save In square. It should say My Documents. In the block below yellow 
folders will appear if you have made them. (See Step 2 in Using MSWORD as an Office) Click on the folder you want 
to save the document in. Click on Open. Then check that you like the name of the document. If you like it press save. 
If you don’t like it delete the file name and type a new name. Then click save. 

If your document is an update of an old document but you want to save it as a new version click on Version in the 
Save box under file. Type in your comments and click Save. (I don’t use this much as I just give the document a new 
date and use Save As to save it under a new name.) 

The next section is to do with how the document looks (Page Set Up) and Print Preview and to print documents. 

Page set up allows you to change the margins of the page so that you can get more (or less) typing on a page. If you 
click on Paper Size it allows you to change the page into Portrait (normal A4) or Landscape (sideways A4) 

Print preview allows you to see what the document will look like on a printed page. You can also to this by using the 
block on the toolbar with a page and magnifying glass on it. 

Print allows you to print the document if your computer is connected to a printer. You can also print quickly by using 
the block with a printer on your toolbar. 

The next section allows you to Send your document either to another computer via email or to a fax machine. Your 
computer has to be set up for this. You can also email your document by using the block on the bottom toolbar with an 
envelope on it. Properties allows you to store information about your document. 

The next section is a list of the last four documents you worked on. Clicking on the right file name is a quick way of 
opening the any of these documents. 
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The last section says Exit. If you click on this the MSWORD programme will shut down and you can return to 
Windows. If you have forgotten to save any documents the computer will ask you if you want to Save. Click on Yes or 
No. You can also exit or close down MSWORD by clicking on the X in the last square on the top right hand side of the 
screen. 

The Edit title 

This section allows you to change or edit your work. 

The most useful tools in the list are Cut, Copy and Paste. 

Cut: this allows you to delete a section but not to throw it away completely in case you need it later. Use your mouse 
and drag it over the section you want to delete. Then go to Edit. Click Cut. If you want to use it again you can add it in 
later or move it to another section. You use the Paste command to move the section to a new place. Take your cursor 
to where you want to place the section. Click on Edit. Click Paste and the cut section will be pasted or put in this new 
place. We call this Cutting and Pasting. 

You can also Copy a section of your work and use it again. Highlight the section with your mouse. Click on edit. Click 
on Copy. Then take your cursor to the new place you want to put it. Click on Edit. Click Paste and the section will be 
repeated. 

If you want to do it quickly, you can use the scissors symbol on your toolbar to cut, the two pages next to it to copy 
and the clipboard next to that, to paste.  

WARNING: Your computer will only keep the last section that you cut or copied. As soon as you cut or copy another 
section, the first one will be deleted. 

The View title 

When you type a document the view on screen is in Normal mode – or as it appears on the screen. You can look at it 
in Layout (as it would appear) printed or in other ways. A quick way of looking at your page layout is to use the toolbar 
and click on the blank page with a magnifying glass on it. 

You can also change your Toolbar using View. Just click next to the tools you want displayed on the screen. Do not 
open too many since the part of your screen that you type on will become very small. It is best to leave this until you 
know your computer well, as it is not really necessary! 

If you have poor eyesight you can change the size of the letters you see on screen. Use the Zoom command at the 
bottom of View and set your view to 100% or more – just click next to 100% if that is big enough or go down to the box 
at the bottom and type in 110%.  

The Insert title 

This is useful for inserting Page Breaks (that is, beginning a new page), page numbers, footnotes, pictures and so on. 

You can also use this box to insert page numbers. Click on Page Numbers and then click on OK. If you want to copy 
documents on both sides of a page, it is best to put your page number in the middle of the page at the bottom. To do 
this click on the box called Alignment and then click on Centered. 

Play with this box on a practice document to see what you can do with it. 

The Format title 

This is useful for layout or making your document look attractive. There are various headings. 

Font: This is the type of print or shape of print you are using. Your MSWORD programme comes with a few options 
like Arial, New Times Roman, Century Gothic and so on. You can set the font type and the size of letters for a 
document before you start working. The format also appears in the second white block on the toolbar below the titles, 
with an arrow next to it and followed by a block with a number in it and another arrow. You use these to quickly 
change the font and the size of the font. So you can write big or small and in different styles. For normal typing is best 
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to use a font size of 11 or 12. For headings you can use a bigger size or make the headings in bold. Just highlight the 
heading and then click on the B at the top of your screen. Fonts are fun to play with. 

Paragraph: The paragraph section allows you to change the margins of a paragraph. It also allows you to change 
your line spacing to single, or bigger. You can also make the gaps between paragraphs a bit bigger – just click on 
Paragraph and then on Spacing Before – change the 0 to 0.6. 

Bullets and Numbers: Bullets allow you to mark points in different ways, using dots, or arrows or blocks and so on. 
Highlight the section you want to bullet and then click on Format, then on Bullets and Numbering and then on the type 
of bullets you like. A new bullet will appear wherever you pressed enter to make a new paragraph. Numbers allow you 
to number your sentences or paragraphs in different styles (a, b, c, 1, 2, 3 and so on.) 

The quick way to do this is by clicking on the little blocks with numbers or the little block with dots (bullets) on your 
toolbar. 

Borders and shading: allows you to put a border around your whole document or to put a box or border around a 
paragraph. Highlight the piece you want to border. Go to Format. Go to Borders and click on the kind of border you 
want. You can also put in a background shade. Play with this until you find the style you like best. 

The quick way to place a border around a section is to highlight it and then to click on the square on the top toolbar 
near the right end. 

Columns: allow you to arrange your whole document into columns. Normally it is in one column, but you may want to 
make it look like a newspaper and have different columns. I think it is easiest to do this before you begin typing, but 
you can do it afterwards. Decide on how many columns you want. Go to Format. Click on Columns. Click on the style 
you like and then type. 

Change case: Sometimes one types in capitals by mistake. Rather than retyping the whole section you can highlight 
it. Go to Format. Go to Change case. Click on Sentence case and it will correct it for you. 

The Tools title 

This has a helpful button to check the spelling in your whole document. 

Miss-spelt words are underlined in red as you make the error. It is quicker to correct all the errors at the end, rather 
than do them one by one. You do this by going to Tools. Click on Spelling. The spell-check will give you options – 
click on the correct spelling and the click on Change. If the word is correctly spelt, but not in their dictionary click on 
Ignore or Add. 

You can also highlight a word you are not sure of and the click on the ABC symbol on your toolbar. 

The Table title 

Often we want to arrange information in tables. Decide whether you need a table. Decide how many columns you 
want. Then go to Table before you type the information you want in the table. 

Insert Table allows you to make a new table. Click on the number of lines and columns you need. You can change 
the numbers by clicking on the little black arrows next to the number. Then click on OK. The computer will put in a 
table for you. You can change the size of the columns by using your mouse to drag the downward lines closer or 
further apart. Then type in your 

information in the columns you want. If you want lines and borders to appear on the table when it is printed click on 
the borders box on the toolbar. A new toolbar will open. Go to the border box on that toolbar and click on the arrow 
next to it and then on the box with gridlines on it. 

The Window title 

I never use this but it allows you to work on two documents at once. 
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The Help title. 

Play with this. It will tell you how to do things. The contents are arranged alphabetically and you find out more about 
what you want your MSWORD to do. 

The toolbar 

Look at your toolbar. On the top left it will show the font and size in white boxes. You can change your font and its 
size by clicking on the arrows next to each and selecting what you want. 

These are a quick way for you to make some words or headings Bold (B), to type some words in italics (I) or 
to underline them (U). 

Then there are 4 blocks with lines in them. These can align your typing in different ways. Get to know them by typing 
a paragraph and highlighting it. Then try what each looks by clicking each of the 4 blocks. The first one is the normal 
way your text will be aligned. The second one centres your typing in the middle of the page. It is most useful to make 
headings if you want them in the centre of the page. The third one is not used often since it aligns the right side of 
page and the left side is uneven. The fourth one is used to align both sides – this makes your document look nice, but 
it sometimes stretches out the spaces between words and can make a line look strange 

Then there are the numbers and bullets tools. Highlight the section you want numbered or bulleted and click on the 
right tool. If you do not like the type of bullets or numbers you will have to go to format and change the bullet type and 
then click on Reset [if you want to use this type for bullets in your whole document] and OK. 

The next two tools have stripes and an arrow. The are useful for indenting a paragraph. Highlight the paragraph and 
the click on the first one to move it to the left and the second one to move it to the right. 

A square box is the next tool. This can help you arrange your borders quickly. Click the mouse button on the arrow 
next to it and it will give you the options. Choose the one you like and click on it. 

If you go to any other tool on the third line with your mouse, it will light up and tell you what it is for. We covered most 
of them already. A very useful tool is the curved blue arrow. This is called the undo button and it reverses an action 
you have taken that you don’t like. So if you deleted something and want to put it back – click undo immediately. 

CREATING A DOCUMENT IN MS WORD 
 
Starting a New Document:-  

Step 1:-  Click on Start Button of window and then click on Ms word in 
all Programme list in the start menu. 

 
Figure 1 

Step 2:- You already have a new document on the screen, but since it 
has been opened by Word itself,  you must try to open another new 
document for creating a newer one. 
 
 
Step 3.:- Click the 'Office' button to open the drop-down menu and click 
the ‘New’ menu option (see Figure1). This brings up a the 'New  

Document' window (see Figure 2) showing the list of available templates 
on the basis of which you can start a new document. you will use the 
blank document template which is already selected. 

 

 
 

Figure 2 

Step4. :- Click the ‘Create’ button. A new Word window will open with a 
blank document.  

 

TIP! 

Instead of following the sequence Office button > New > Blank Document > Create, you can create a 
new document using the keyboard shortcut Ctrl + N, i.e. by pressing the ‘Control’ and ‘N’ keys at the 
same time. 
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                                TYPING TEXT INTO DOCUMENT 

 
Step 1: Start typing. As you type, the letters will appear one by one at the cursor. Each press of a letter key 
will produce the letter on the screen in lowercase. For uppercase letter i.e. capital letter, press the letter 
key along with the Shift key. When a typed letter shows up, the cursor will move to its right. 
 
Step 2: When you have typed all letters of the first word, press the ‘Space Bar’ once before starting to 
type the second word. Space bar is used to separate one word from another by inserting space between 
them. 
 
Step3: Keep typing, pressing the space bar after each word. When the cursor reaches the end of the line, 
the text typed further will automatically move to the next line below. This is called text wrapping, which 
MS Word 2007 does automatically for you. 
 
Step 4: Keep typing until you reach the end of the text. 
 

Starting A New Paragraph 
 

Step1. Press the Enter key once You will see the cursor jump to the beginning of the next line below the 
first paragraph. Pressing the Enter key (also called the ‘Return’ key) starts a new paragraph. 
 
Step 2. Now type the text in the new paragraph. 
 
 

                                
 

FORMATTING TEXT IN A  DOCUMENT 

To change the font: 

By default, the font of each new document is set to Calibri. However, Word provides many other fonts you can use to customize text 
and titles. 

1. Select the text you want to modify. 

 

 

2. On the Home tab, click the drop-down arrow next to the Font box. A menu of font styles will appear. 

3. Move the mouse over the various font styles. A live preview of the font will appear in the document. Select the font style you want to use. 
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4. The font will change in the document. 

 

 

When creating a professional document or a document that contains multiple paragraphs, you'll want to select a font 
that's easy to read. Along with Calibri, standard reading fonts include Cambria, Times New Roman, and Arial. 

To change the font size: 

1. Select the text you want to modify. 

 

 

2. Select the desired font size formatting option: 

o Font size drop-down arrow: On the Home tab, click the Font size drop-down arrow. A menu of font sizes will appear. When 

you move the mouse over the various font sizes, a live preview of the font size will appear in the document. 
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o Font size box: When the font size you need is not available in the Font size drop-down arrow, you can click the Font size box 

and type the desired font size, then press Enter. 

 

 

o Grow and shrink font commands: Click the Grow Font or Shrink Font commands to change the font size. 

 

 

3. The font size will change in the document. 

 

 

To change the font color: 

1. Select the text you want to modify. 

 

 

2. On the Home tab, click the Font Color drop-down arrow. The Font Color menu appears. 

3. Move the mouse over the various font colors. A live preview of the color will appear in the document. 
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4. Select the font color you want to use. The font color will change in the document. 

 

 

Your color choices aren't limited to the drop-down menu that appears. Select More Colors... at the bottom of the menu to 
access the Colors dialog box. Choose the color you want, then click OK. 

 

To highlight text: 

Highlighting can be a useful tool for marking important text in your document. 

1. Select the text you want to highlight. 

 

 

2. From the Home tab, click the Text Highlight Color drop-down arrow. The Highlight Color menu appears. 

 

 

3. Select the desired highlight color. The selected text will then be highlighted in the document. 

 

To remove highlighting, select the highlighted text, then click the Text Highlight Color drop-down arrow. Select No 
Color from the drop-down menu. 
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If you need to highlight several lines of text, changing the mouse into a highlighter may be a helpful alternative to 
selecting and highlighting individual lines. Click the Text Highlight Color command, and the cursor changes into a 

highlighter . You can then click, hold, and drag the highlighter over the lines you want to highlight. 

To use the Bold, Italic, and Underline commands: 

The Bold, Italic, and Underline commands can be used to help draw attention to important words or phrases. 

1. Select the text you want to modify. 

 

 

2. On the Home tab, click the Bold (B), Italic (I), or Underline (U) command in the Font group. In our example, we'll click Bold. 

 

 

3. The selected text will be modified in the document. 

 

 

To change the text case: 

When you need to quickly change text case, you can use the Change Case command instead of deleting and retyping text. 

1. Select the text you want to modify. 
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2. On the Home tab, click the Change Case command in the Font group. 

3. A drop-down menu will appear. Select the desired case option from the menu. 

 

4. The text case will be changed in the document. 

 

 

To change text alignment: 

By default, Word aligns text to the left margin in new documents. However, there may be times when you want to adjust text 
alignment to the center or right. 

1. Select the text you want to modify. 

2. On the Home tab, select one of the four alignment options from the Paragraph group. 

 

 

•  
Align Text Left: This aligns all selected text to the left margin. The Align Text Left command is the most common alignment and is selected by default when 
a new document is created. 

•  

• Symbols 

Sometimes you may find that you need to add a symbol to your text, such as the Copyright symbol ©. Word offers a 
collection of symbols for currency, languages, mathematics, and more. 

 

To insert a symbol: 

1. Place the insertion point in the location where you want to insert a symbol. 
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2. On the Insert tab, click the Symbol drop-down arrow. A menu of symbols will appear. 

3. Select the desired symbol. 

 

 

4. The symbol will appear in your document. 

 

 

If you don't see the symbol you're looking for, click More Symbols... to open the Symbol dialog box. Locate and select the 
desired symbol, then click Insert. 

 

 

 

 

 

 

INSERTING IN MS WORD DOCUMENT 

 
COVER PAGE:-  
Cover page option is used for selecting the different styles of first page of the document. In cover page option 
different styles of cover page styles available. Choose one and it automatically set it on the from page of the 
document. 
 
BLANK PAGE:-  
Blank Page options insert the new blank page with no styles and text. 
 
PAGE BREAK:-  
Page Break brings the new page in the document. 
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TABLE:  
To quickly insert a basic table, click Insert > Table and move the cursor over the grid until you highlight the 

number of columns and rows you want.  

 

Click and the table appears in the document. If you need to make adjustments, you can add table rows and 

columns, delete table rows and columns, or merge table cells into one cell. 

When you click in the table, the Table Tools appear. 

 
Use Table Tools to choose different colors, table styles, add a border to a table or remove borders from a table. 
You can even insert a formula to provide the sum for a column or row of numbers in a table. 
If you already have text in your document that would look better as a table, Word can convert the text to a table. 
 

Insert larger tables or tables with custom widths 
 
For larger tables and for more control over the columns, use the Insert Table command. 

 

This way you can create a table with more than ten columns and eight rows, as well as set the column width 

behavior. 

1.  Click Insert > Table > Insert Table. 

2. Set the number of columns and rows 

 

3. In the AutoFit behavior section you have three options for setting how wide your columns are: 

o Fixed column width: You can let Word automatically set the column width with Auto, or you can 

set a specific width for all of your columns. 
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o AutoFit to contents: This will create very narrow columns that will expand as you add content. 

o AutoFit to window: This automatically changes the width of the entire table to fit the size of your 

document. 

4. If you want each table you create to look like the table you’re creating, check Remember dimensions for 

new tables. 

Design your own table by drawing 

NOTE: Applies to desktop versions of Word only. Does not apply to Word Online. 

If you want more control over the shape of your table’s columns and rows or something other than a basic grid, 

the Draw Table tool helps you draw exactly what you want. 

 

You can even draw diagonal lines and cells within cells. 

1. Click Insert > Table > Draw Table. The pointer changes to a pencil. 

2. Draw a rectangle to make the table’s borders. Then draw lines for columns and rows inside the rectangle. 

 

3. To erase a line: 

o In Word 2013 and Word 2016: Click the Table Tools Layout tab. 

o In Word 2007 and Word 2010: Click the Table Tools Design tab. 

Click Eraser, and then click the line that you want to erase. 

 

4. If you want to distribute all of the rows and columns evenly, on the Table Tools Layout tab, in the Cell 

Size group, click Distribute Rows or Distribute Columns. 
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PICTURE:- 

To insert a picture:  

 

 

• Click on Insert 

• Click Picture 

• Browse for the image file (Picture chosen) 

• Select it 

• Click on Insert 

 

 

 

 

The picture will appear on your page in Word, you can also adjust the size, image quality, color and add effects!  

 

CLIP ART: 
Clip art options insert various types of clips types shapes stored in computer. 
 

SHAPES: 
If we want to insert some shapes in documents like arrow, line, circle, etc. then we use this functions, simpley select the shape 
and insert into document . 
 

CHART: 

Chart options inserts various types of charts styles in our document. 
 

HYPERLINK: 

WHAT IS A HYPERLINK? 

A hyperlink is basically a location address inserted into a document that links to another object or location. An object can be a Word file, an 
HTML web page, an image, sound file, video or other digital file. 

The address can also link to a location within the original document, allowing the reader to jump to different sections of the document. 
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Hyperlinks are clickable and take a user to the target location or object. 

TYPES OF HYPERLINKS 

There are a few basic types of hyperlinks that can be included in a Word document: relative, absolute and anchors. 

• An absolute hyperlink is a full address for the document to be linked to. It includes every location detail necessary to follow the 
path to the linked document from anywhere. The document linked to can be virtually anywhere your computer is able to access, 
from your hard drive to a location on the Web. 

• A relative hyperlink is a shorter address that only includes the location details necessary to follow the path from the document's 
current location to another document within the same location. Thus the hyperlink connects to another document relative to its 
current location. The linked document can be in the same location, or it can be in a subfolder, but it cannot be outside of the 
original document's location. 

• An anchor link connects locations within the same document. For example, a table of contents might consist of anchor links that 
take the reader to specific chapters within the document. 

INSERTING A HYPERLINK IN YOUR WORD DOCUMENT 

To insert a hyperlink in your Word document, follow these steps: 

1. Select the text you want to turn into a hyperlink. 

1. Right-click on the text and select Hyperlink... in the context menu.This opens the Insert Hyperlink dialog box. 
2. The text you selected for the hyperlink will populate the field labeled "Text to display." You can change this if needed. 
3. Under the "Link to" column, click what you'll be linking to (e.g., a web page, a place within the current document, another 

document, etc.).  
4. Use the center pane to complete the information required for the hyperlink. For example, if you're linking to a Web page, enter 

the URL of the page in the field labeled "Address." 
5. When you are finished, click OK. 

 

BOOKMARK: 

Insert Bookmark Into Document With Bookmark Function In Word 

Microsoft Office Word provides users with bookmark to identify locations or selected text. Do as follow to insert bookmark into document in Word: 

Step 1: Select the desire text or put the cursor at the desire location; 

Step 2: Click Insert tab, click Bookmark in Links group; 

   Step 3: In Bookmark window, set a name to bookmark in Bookmark name box: 

   Step 4: Click Add button. 

 

HEADER - FOOTER - PAGE NO. 
The header is a section of the document that appears in the top margin, while the footer is a section of the document that appears in 
the bottom margin. Headers and footers generally contain additional information such as page numbers, dates, an author's name, 
and footnotes, which can help keep longer documents organized and make them easier to read. Text entered in the header or footer will 
appear on each page of the document. 

To create a header or footer: 

In our example, we want to display the author's name at the top of each page, so we'll place it in the header. 

1. Double-click anywhere on the top or bottom margin of your document. In our example, we'll double-click the top margin. 
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2. The header or footer will open, and a Design tab will appear on the right side of the Ribbon. The insertion point will appear in the header 

or footer. 

 

 

3. Type the desired information into the header or footer. In our example, we'll type the author's name. 

 

 

4. When you're finished, click Close Header and Footer. Alternatively, you can press the Esc key. 

 

 

5. The header or footer text will appear. 
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To insert a preset header or footer: 

Word has a variety of preset headers and footers you can use to enhance your document's design and layout. In our example, we'll 
add a preset header to our document. 

1. Select the Insert tab, then click the Header or Footer command. In our example, we'll click the Headercommand. 

 

 

2. In the menu that appears, select the desired preset header or footer. In our example, we'll select a header. 

 

 

3. The header or footer will appear. Preset headers and footers contain placeholders for information such as the title or date; they are known 

as Content Control fields. 

 

 

4. To edit a Content Control field, click it and type the desired information. 

 

 

5. When you're finished, click Close Header and Footer. Alternatively, you can press the Esc key. 

 

http://www.jatinderjyoti.in/
mailto:jatinderjyoti84@gmail.com


JATINDER SINGH                             www.Jatinderjyoti.in                   jatinderjyoti84@gmail.com                        FB/jatinderjyoti.raina Page 24 
 

 

If you want to delete a Content Control field, right-click it and select Remove Content Control from the menu that appears. 

 

Editing headers and footers 

After you close the header or footer, it will still be visible, but it will be locked. Simply double-click a header or footer to unlock it, 
which will allow you to edit it. 

 

 

• Additional options: With the Page Number command and the commands available in the Insert group, you can add page numbers, 

the date and time, pictures, and more to your header or footer. 
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To insert the date or time into a header or footer: 

Sometimes it's helpful to include the date or time in the header or footer. For example, you may want your document to show 
the date when it was created. 

On the other hand, you may want to show the date when it was printed, which you can do by setting it to update automatically. 
This is useful if you frequently update and print a document because you'll always be able to tell which version is the most recent. 

1. Double-click anywhere on the header or footer to unlock it. Place the insertion point where you want the date or time to appear. In our 

example, we'll place the insertion point on the line below the author's name. 

 

 

2. The Design tab will appear. Click the Date & Time command. 

 

 

3. The Date and Time dialog box will appear. Select the desired date or time format. 

4. Check the box next to Update Automatically if you want the date to change every time you open the document. If you don't want the 

date to change, leave this option unchecked. 

5. Click OK. 

 

 

6. The date will appear in the header. 
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Adding page numbers 

Word can automatically label each page with a page number and place it in a header, footer, or side margin. When you need 
to number some pages differently, Word allows you to restart page numbering. 

To add page numbers to a document: 

In our example, we'll add page numbering to our document's footer. 

1. Double-click anywhere on the header or footer to unlock it. If you don't already have a header or footer, you can double-click near 

the top or bottom of the page. The Design tab will appear on the right side of the Ribbon. 

 

 

2. Click the Page Number command. In the menu that appears, hover the mouse over Current Position and select the desired page 

numbering style. 

 

 

3. Page numbering will appear. 
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4. To edit the font, font size, and alignment of page numbers, select a page number and click the Home tab. Word's text formatting options 

will appear. 

 

 

5. When you're finished, press the Esc key. The page numbering will be formatted. 

 

 

Alternatively, you can add page numbers to the header or footer by clicking the Page Number command and then selecting Top 
of Page or Bottom of Page. If you have an existing header or footer, it will be removed and replaced with the page number. 

 

To restart page numbering: 

Word allows you to restart page numbering on any page of your document. You can do this by inserting a section break and then 
selecting the number you want to restart the numbering with. In our example, we'll restart the page numbering for our 
document's Works Cited section. 

1. Place the insertion point at the top of the page you want to restart page numbering for. If there is text on the page, place the insertion 

point at the beginning of the text. 

 

 

2. Select the Page Layout tab, then click the Breaks command. Select Next Page from the drop-down menu that appears. 
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3. A section break will be added to the document. 

4. Double-click the header or footer that contains the page number you want to restart. 

 

 

5. Click the Page Number command. In the menu that appears, select Format Page Numbers. 

 

 

6. A dialog box will appear. Click the Start at: button. By default, it will start at 1. If you want, you can change the number. 

7. Click OK. 
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8. The page numbering will restart. 

 

 

 

BULLETED AND NUMBER LIST IN MICROSOFT WORD 

 

How to create a bullet list in Microsoft Word 

To create a bulleted list in Microsoft Word, follow the steps below. 

Tip: The Microsoft word keyboard shortcut key to create a bullet is Ctrl+Shift+L. 
1. Position the cursor where you want to insert the bullet list. 

2. Either click on the bullet button (as shown at the beginning of the document) or click Format and then "Bullets and Numbering..." 
3. If successful, you should have a bullet. Type any text and press enter to start the next bullet. To end the bullet list, press enter twice. 

Below is an example of a bullet list. 

• One bullet 

• Two bullet 

How to create a numbered list in Microsoft Word 

To create a numbered list in Microsoft Word, follow the steps below. 
1. Position the cursor where you want to insert the number list. 

2. Either click on the number button (as shown at the beginning of the document) or click Format and then "Bullets and Numbering..." 

3. If successful, you should have a number one. Type any text and press enter to start the next number in the numbered list. To end the numbered 
list, press enter twice. 

Above is an example of a numbered list. 

How to create a numbered list with letters 

To create a numbered list that also contains a letter list in Microsoft Word, follow the steps below. 
1. Position the cursor where you want to insert the number list. 

2. Either click on the number button (as shown at the beginning of the document) or click Format and then "Bullets and Numbering..." 
3. When you want to enter a letter list, press the indent button or press tab on the keyboard. 

4. If you with to change the lettering format or if it is improperly working, click Format and then "Bullets and Numbering..." again to change the 

formatting. 

Below is an example of a numbered list with letters in it. 
1. One numbered 

2. Two numbered 

     a. Two numbered again 
     b. Two numbered again 

3. Final numbered 
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How to create multiple paragraphs without creating a new bullet or number 

In some situation you may need to have multiple paragraphs in a numbered or bullet list. To do this, follow the steps below. 
1. Position the cursor where you want to insert the number list. 
2. Either click on the number button or bullet button (as shown at the beginning of the document) or click Format and then Bullets and Numbering. 

3. When you're ready to insert a new line without creating a new bullet or number, press Shift+Enter. 

Below is an example. 
1. One numbered 
2. Two numbered 

 

More text without a number 
3. Final numbered. 

How to create a bullet list with a numbered list 

To create a numbered list that also contains a letter list in Microsoft Word, follow the steps below. 
1. Position the cursor where you want to insert the number list. 

2. Either click on the bullets button (as shown at the beginning of the document) or click Format and then "Bullets and Numbering..." 
3. When ready to insert a numbered list within the bullets, press the bullets button or click Format and then "Bullets and Numbering..." 

4. When you need to switch back to bullets, click the numbering button again or click Format and then "Bullets and Numbering..." 

How to create a numbered list with a bulleted list 

To create a numbered list that also contains a letter list in Microsoft Word, follow the steps below. 
1. Position the cursor where you want to insert the number list. 
2. Either click on the number button (as shown at the beginning of the document) or click Format and then "Bullets and Numbering..." 

3. When ready to insert a bullet list within the numbered list, press the numbering button or click Format and then "Bullets and Numbering..." 

4. When you need to switch back to the numbered list, click the bullets button again or click Format and then "Bullets and Numbering..." 

How to change the bullets used or change the appearance of the numbers 

After creating the numbering list or the bullets list, if you need to change the appearance, click Format and then the "Bullets and 

Numbering..." option. You can adjust the format through the new Bullets and Numbering window. Below, is an example of what 

this window may look like in Microsoft Word. 
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PAGE SETUP IN MS WORD 

Use the Page Setup Dialog box to change the margins in a document, to change the paper size, and to change the 

layout of the document. After calling up the Page Setup Dialog box, you see three tabs: Margins, Paper, and Layout. 

When working in these tabs, you can apply the changes to the Whole Document,  

WORD MARGINS TAB 

This tab allows you to set the margins in the document. You can set the following margins: 

• Top: Sets the distance from the top of the page to the first line of text. 

• Bottom: Sets the distance from the bottom of the page to the last line of text. 

• Left: Sets the distance from the left edge of the page to the start of the text. 

• Right: Sets the distance from the right edge of the page to the end of the text. 

• Gutter: Sets an additional amount of margin space for pages that are to be bound. 

 

THE PAPER TAB IN WORD 

This tab includes the following options for setting your paper size: 

• Paper Size: Allows you to pick from a variety of paper sizes, including Letter, Legal, and various other 

envelope sizes. 

• Width: Sets the width of the paper and is automatically set when you choose a Paper Size. If you change the 

value of this field, the Paper Size field changes to Custom Size. 

• Height: Sets the height of the paper and is set automatically according to the Paper Size. Changing the 

height automatically changes Paper Size to Custom Size. 
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WORD’S LAYOUT TAB 

This tab has the leftovers that don’t fit in the other tabs, such as the Line Numbers control and formatting sections, 

headers, footers, and page alignment. 

 

 

SAVING A DOCUMENT ON MS WORD 

 

 
It's important to know how to save the documents you are working with. There are many ways you share and 

receive documents, which will affect how you need to save the file.  

 

 

 

How to save documents 

To use the Save As command: 

• Click the Microsoft Office button. 

• Select Save As Word Document. The Save As dialog box appears. 
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• Select the location where you want to save the document using the drop-down menu. 

• Enter a name for the document. 

 

• Click the Save button. 

To use the Save command: 

• Click the Microsoft Office button. 

• Select Save from the menu. 

Using the Save command saves the document in its current location using the same file name. If you are saving for the first t ime and 
select Save, the Save As dialog box will appear. 

To Save As a Word 97 - 2003 document: 

• Click the Microsoft Office button. 

• Select Save As Word 97-2003 Document. 

 

• Select the location where you want to save the document using the drop-down menu. 

• Enter a name for the document. 
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• Click the Save button. 

To download the PDF extension: 

• Click the Microsoft Office button. 

• Select Save As Find add-ins for other file formats. This will open your web browser to the Microsoft site. 

• Follow the instructions on the Microsoft site for downloading the extension. 

To save as a PDF: 

• Click the Microsoft Office button. 

• Select Save As PDF. The Save As dialog box will appear. 

 

• Select the location where you want to save the document using the drop-down menu. 

• Enter a name for the document. 

• Click the Publish button. 

 

 

PRINTING A DOCUMENT IN MS WORD 

How to print a document 

To print a document, your computer needs to be connected to a printer. Being able to print is not necessary in order to use Word, but if 

you want to send a letter in the post or print out a poster, you’ll need to have access to a printer. 

  

This guide explains how to print a document in Microsoft Word 2010. Earlier versions of Word may use slightly different steps. 

  

You’ll need: 

  

• A computer with Microsoft Word installed. 

• A printer set up and connected to your computer. 
Follow these step-by-step instructions to print a document from Microsoft Word 

  

Step 1: Open an existing Word document or start a new document and type your text. 

  

Step 2: Once you’ve completed your document and are ready to print, click Filein the top left-hand corner of your document. 

  

Alternatively, some versions of Word may have an Office button instead of a ‘File’ button – it’s a round Office icon in the top left-hand corner of the 

screen. Click on this if you have one. 
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 Step 3: Move down and click Print in the menu. This will bring up the ‘Print’ dialogue box. 

  

 Step 4: Choose how many copies of your document you need. 

  

 Step 5: Depending on your printer options, you can choose other printing features such as whether you want to print all pages or only certain 

pages. You can also change the orientation of the print from portrait to landscape and tell your computer and printer whether you’re printing on a 

certain size of paper. You’ll also see, on the right, a preview of your printed document will look like. 

 Step 6: When you’re happy with your settings, click Print. The document will now start printing on your printer. 
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NAVIGATING A DOCUMENT IN MS WORD 
 

As you start to work with larger documents such as manuals and novels it can become harder to 
navigate to a particular page or the end of a document. 
There are a variety of techniques for navigating a document: 
 

Scroll Bars 
 
The most simple way of navigating a document is to use the scroll bars. 
A vertical scroll bar is located to the right of the window and enables you to scroll up and down 
through a document. A horizontal scroll bar is located along the bottom of the window (if the 
document is of a sufficient width) and allows the use of left and right scrolling. 
To use the scroll bars either click and hold the arrow, or click and drag the scroll box for faster 
scrolling 

 

MOVE AROUND WORD WITH BASIC ARROW KEYS 

You can take advantage of the keyboard’s cursor keys to quickly move the insertion pointer to any position in a 

document. The four basic arrow keys move the insertion pointer up, down, right, and left. 

Press This Key To Move the Cursor Here 

↑ Up to the preceding line of text 

↓ Down to the next line of text 

→ Right to the next character 

← Left to the preceding character 

USE ARROW-KEY COMBINATIONS TO NAVIGATE IN WORD 

If you press and hold the Ctrl (Control) key and then press an arrow key, you enter hyperjump mode. The 
supercharged insertion pointer leaps desperately in all four directions: 

Press This Key 

Combination 

To Move the Cursor Here 

Ctrl+↑ Up to the beginning of the previous 

paragraph 

Ctrl+↓ Down to the beginning of the next paragraph 

Ctrl+→ Right to the beginning (first letter) of the 
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next word 

Ctrl+← Left to the beginning (first letter) of the 

previous word 

 

MOVE FROM BEGINNING TO END IN A WORD DOCUMENT 

End and Home move the insertion pointer to the start or end of something, depending on how they’re used. 

Key or Combination To Whisk the Insertion Pointer Here 

End To the end of a line of text 

Home To the beginning of a line of text 

Ctrl+End To the end of the document 

Ctrl+Home To the tippy-top of a document 

MOVE BY USING THE WORD PGUP AND PGDN KEYS 

You might think that the Page Up or PgUp key moves a document up one page and that the Page Down or PgDn key 

moves a document down. Rather than slide the document around a page at a time, these keys move things 

one screen at a time: 

Press This Key or Key 

Combination 

To Move the Insertion Pointer 

Here 

PgUp Up one screen 

PgDn Down one screen 

Ctrl+Alt+PgUp To the top of the current screen 

Ctrl+Alt+PgDn To the bottom of the current screen 
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MAIL MERGE 
 
Definition –  

Mail merge is a feature within most data processing applications that enables users to send a 
similar letter or document to multiple recipients. It enables connecting a single form template 
with a data source that contains information about the recipient’s name, address and other 
pre-defined and supported data 

Mail merge is a process to create personalised letters and pre-addressed envelopes or mailing 
labels for mass mailings from a form letter. The feature is usually employed in a word 
processing document which contains fixed text (which is the same in each output document) and 
variables (which act as placeholders that are replaced by text from the data source). The feature 
dates back to early word processors on personal computers, circa 1980. WordStar was perhaps the 
earliest to provide this, originally via an ancillary program called Mail merge. WordPerfect also 
offered this capacity for CP/M and MS-DOS systems, and Microsoft Word added it later on. 

The data source is typically a spreadsheet or a database which has a field or column for each 
variable in the template. When the mail merge process is run, the word processing system creates 
an output document for each row in the database, using the fixed text exactly as it appears. 

The mail merging process generally requires the following steps: 

1. Creating a Main Document/Template. 

2. Creating a Data Source. 

3. Defining the Merge Fields in the main document. 

4. Merging the Data with the main document. 

5. Saving/Exporting. 

 
 

How to Mail Merge in Microsoft Word 
Mail Merge is a powerful tool for writing and sending a personalized letter or e-mail to many 
different people at the same time. You can also use it to create envelopes or labels with each 
recipient' information. Mail Merge imports data from another source such as Excel and then 
uses that data to replace placeholders throughout your message with the relevant information 
for each individual you are messaging. You can use it to quickly create personalized messages 
for hundreds of people at once. 
 
PART 1. ADDING RECIPIENTS: 

1Understand what the Mail Merge function allows you to accomplish. Mail Merge is a feature designed for creating mass mailing and 

emails, as well as envelopes and labels with different information on each one. You can load a database of recipients or manually enter 
them, and then use placeholders, or "Fields", to automatically fill in each recipient's information in their own copy. This allows you to 
create one document that you can send to hundreds or even thousands of people. 

1.  

2 

Create a recipient spreadsheet (optional). You can manually enter each recipient during the Mail Merge process, which is fine if you have 

just a handful of people you're messaging, but you'll find things a lot easier if you have a spreadsheet or database of your recipients 

before you start. 

 

3 

Click the "Mailings" tab to open the Mail Merge tools. If you are using Word 2003 or older, click the "Tools" menu and select "Letters and 

Mailings" → "Show Mail Merge Toolbar". 
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4 

Click the "Start Mail Merge" button and select your format. You can use Mail Merge to create emails, letters, envelopes, labels, and 

directories. You can also select "Normal Word Document" if you're not sure. 

• If you select "Envelopes", the Envelope Options window will appear, allowing you to choose how your envelopes will be formatted as 

well as the physical envelope size. 

• If you select "Labels", the Label Options will appear, allowing you to choose the type of label paper as well as the size of each label. 
 

5 

Click "Select Recipients" and select how you want to add recipients to the Mail Merge. Recipients are the most powerful part of Mail 

Merge, as they allow you to replace placeholders, or "Fields", in the letter with each recipient's personal information. You can manually 

enter your recipients, load a database or spreadsheet file, or load your Outlook contacts. 

• If you select "Type a New List", a new window will open which will allow you to manually enter each recipient's information. This is useful 

if you don't have access to a spreadsheet with your recipients' information in it, but it is also the slowest way to enter the data. You can 

click Customize Columns... to create custom fields for the data you are entering. 

• If you select "Use an Existing List", you can browse your computer for a variety of different spreadsheet and database files, including 

Excel and Access. You can also click the New Source... button and connect to an SQL server online. 

• If you select "Choose from Outlook Contacts", your Outlook contacts will be loaded, and you can deselect all of the contacts you don't 

want to include. 

 

 

 

Part2 

Creating the Document 
1.  

1 

Start creating your document as you normally would. Once you have your recipients entered, you can begin creating your document. You 

can make it from scratch or use any template. It's important to enter your recipients first so that you can use the appropriate fields while 

creating the document. 

 

2 

Click the "Greeting Line" button to create a custom greeting. You can use the preview in the window that appears to see how it will 

appear on each copy of the Mail Merge. 

 

3 

Click the "Insert Merge Field" button and select the field that you want to insert in the document. These fields will then be replaced with 

the data from the recipient database when the documents are generated. 

• For example, if you want the document to display the recipient's first and last name, you would select "First", push Space , then click the 

"Insert Merge Field" button again and select "Last". 

• For another example, you can use the "Address Block" button to create envelopes with each recipient's address printed on it. Type your 

own address into the return address area of the envelope template, and then add the "Address Block" to the recipient area of the 

template. 

• You can select any field that contains recipient data. Make sure that it applies to all of the recipients on the list, as blank fields will be 

very obvious when reading the document. 
 

4 

Click the "Highlight Merge Fields" button to make the inserted fields stand out.This make it easier to tell how the fields look while editing. 
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5 

Click the "Preview Results" button to see how the final product will look. The display will toggle to show the Mail Merge document filled 

out with your first recipient's information. 

 

 

Part3 

Completing the Mail Merge 
1.  

1 

Check for errors. Click the "Check for errors" button to have Word scan each document in the Mail Merge to ensure that all recipients 

have valid data for each of the fields. Any invalid results will be reported, allowing you to fix them before proceeding. 

2.  

2 

Finish the merge process. Once you have finished checking for errors, you can finish the merge process and create the individual 

documents. You have three options when you click the "Finish & Merge" button:[1] 

• "Edit Individual Documents" - You will be able to choose which entries you want to perform this action on. Once you do, a new document 

will be created, with each entry as a new page. You can then go through and make manual edits to each one. 

• "Print Documents" - You will be able to choose which entries you want to perform this action on. Once you do, the documents will be 

sent to your printer, where each individual one will print. 

• "Email Documents" - You will be able to define the Subject line as well as select the Field that contains the recipients' email addresses. 

You will then be able to send the bulk email message off using Outlook. Note that this will immediately send the message, so make sure 

everything looks good! 
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